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Overview 
A carrier class messaging solution with outstanding technical support, AXIGEN Mail Server 
provides speed, security and reliability. A perfect answer to the complex challenges and 
requirements of a dynamic business environment, AXIGEN features Groupware, Personal 
Organizer, Public Folders, Mail Lists, WebMail and much more. 

AXIGEN provides access to user accounts from anywhere through any web-browser or 
email client. The WebMail module allows users to read and compose messages, view and 
add events in the Calendar, accept or cancel Tasks, personalize the looks of the interface 
and many more account administration tasks.  

Purpose of this Document 
The purpose of this document is to provide a complete description of the AXIGEN WebMail 
Service features and configuration. The manual will guide you trough multiple basic tasks 
and detailed configuration options such as working with your emails, folders, Personal 
Organizer, setting filters and auto-responders etc. 

Structure of this document 
This document has 2 chapters: 

• Chapter 1: Presents detailed characteristics and configuration possibilities of your 
user account trough the WebMail Service 

• Chapter 2: Describes how to benefit from AXIGEN's features and capabilities when 
using Outlook as your email client 

• Chapter 3: Presents how you can work with your email account from a mobile phone 
or other mobile device 

Further references 
For details on how to set some of the most common email clients to send and retrieve emails 
see the following knowledgebase articles: 

 Outlook Express 6(SMTP and POP3) 

 Outlook Express 6 (SMTP and IMAP) 

 Microsoft Outlook (SMTP and POP3) 

 Microsoft Outlook (SMTP and IMAP) 

 Thunderbird (SMTP and POP3) 

 Thunderbird (SMTP and IMAP) 

For other administrative tasks please see our online documentation and System 
Administrator’s Manual. 

http://www.axigen.com/knowledgebase/How-to-configure-Outlook-Express-6-to-work-with-AXIGEN-Mail-Server-POP3-SMTP-_44.html
http://www.axigen.com/knowledgebase/How-to-configure-Outlook-Express-6-to-work-with-AXIGEN-Mail-Server-IMAP-SMTP-_39.html
http://www.axigen.com/knowledgebase/How-to-configure-Outlook-2003-to-work-with-AXIGEN-Mail-Server-POP3-SMTP-_40.html
http://www.axigen.com/knowledgebase/How-to-configure-Outlook-2003-to-work-with-AXIGEN-Mail-Server-IMAP-SMTP-_30.html
http://www.axigen.com/knowledgebase/How-to-configure-Mozilla-Thunderbird-to-work-with-AXIGEN-Mail-Server-POP3-SMTP-_43.html
http://www.axigen.com/knowledgebase/How-to-configure-Mozilla-Thunderbird-to-work-with-AXIGEN-Mail-Server-IMAP-SMTP-_33.html
http://www.axigen.com/docs/en/
http://www.axigen.com/usr/files/AXIGEN_System_Administrator_Manual_6.1_v1.0.pdf
http://www.axigen.com/usr/files/AXIGEN_System_Administrator_Manual_6.1_v1.0.pdf
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Chapter 1. Working with the WebMail Module in AXIGEN 
 
This section of the document presents the AXIGEN WebMail Service features and 
configuration from a user's point of view. The following pages will present in detail how to 
connect to the WebMail interface, manage the respective user account, add contacts to the 
address book or create and manage email messages and WebMail folders.  

When accessing the WebMail interface through a browser, the individual user can configure 
all parameters relative to their respective account, except for certain limitations imposed by 
the administrator (in terms of attachment size, mailbox quota, etc.). 

1.1. Accessing/Leaving the WebMail Interface 

Connecting to AXIGEN WebMail 

To connect to AXIGEN WebMail, enter in your browser the IP:port combination where your 
AXIGEN WebMail service is running. In the window thus displayed, enter the WebMail 
username and password provided by the system administrator. 

 

Note: As you can see above, on the bottom-left side of the ‘login’ panel, you are provided 
with the option ‘Click here to switch to the AJAX interface’. This option refers to the 
additional AJAX-based Webmail interface available – as a technology preview – since 
version 7.2beta of AXIGEN Mail Server. 
 
The new, AJAX-based WebMail delivers the usability and performance of a desktop 
application, by featuring new functionalities, such as: keyboard navigation and shortcuts, 
drag-and-drop, live email list view, frequent folders. 
 
To access this additional, completely reshaped interface and enjoy the desktop-like user 
experience, simply click on the above-mentioned option in the ‘login’ panel. 
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Leaving AXIGEN WebMail 

To close the current WebMail session, click the Logout link (right upper corner, next to the 
username and the Settings link). 

 

 
1.2. WebMail Features and Configuration 

Navigating in Your WebMail Account 

The left panel of your WebMail account displays a tree structure containing the folders 
currently existing in your WebMail account. When first accessing your WebMail account, the 
structure looks like this: 
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The folder structure helps you browse and manage the messages in your WebMail account: 

 
Browsing trough messages is possible also with the help of the Page navigation buttons (go 
to first, next, previous, last, or specific (by number) page) above the preview pane. If actions 
are performed on items in a page the interface will remember the page name so when the 
user returns to it will be the exact same page. 

 
The headers of the messages from the folder selected in the left panel are displayed on the 
upper right panel. 

When selecting an email from the upper right panel by clicking on it, the message body will 
be displayed in the lower right Preview Pane. The Preview Pane can also be moved to the 
right of the message list. By default, the Preview Pane displays the sender, recipient(s) and 
date details of the email horizontally. To have them displayed vertically, press the "+" icon in 
front of the Subject line, as shown in the below picture. 

 

Searching within your email account 
You can search through the existing email messages stored in your account using the quick 
search option or the Advanced Search option. 
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For a quick search, go to the left corner of the WebMail page (above the folders tree 
structure), type your query in the search filed and press the Go button. The search results 
will be displayed in the same window and can be sorted by all fields displayed in the 
message list header (From, To, Subject, Date, Size). 
 
For an advanced search, access the more actions menu (under the Settings and Logout 
links) and choose the Advanced Search option. In the new window choose whether the 
query should match all or just part of the specified search elements. Add as many search 
criteria as you need by clicking the add new element link or delete them by hitting their 
corresponding trash-bin shaped button 

 
Use the drop-down menu to select the new search element type. Available options include 
setting search criteria relative to the subject, sender, body, date, send date, To, Cc, size of 
the email, flag, header or raw. To select the folders to search in click the Choose folders 
button and in the new window select them (public folders are not available), they will be 
displayed in the Selected folders section. Finally click the Search button to find the needed 
information. 

NOTE: The Search function also supports internationalized searches. Having this feature, 
language-specific characters can now be used when running a search (i.e. using diacritics). 

1.3. Working with Messages in WebMail 

Main Button Bar 

 
Use the New button to create a new email message. The Reply and Reply to All buttons 
allow you to reply to a particular email message or to all previously selected messages. Use 
the Forward button to redirect a received email to a different recipient and the Move button 
to move an email message to a different folder. The Delete button allows you to delete 
previously selected messages. 

For further actions on email messages, use the More actions drop down menu, which 
allows you to access the Advanced search, group email messages by conversation, subject, 
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sender or not group them at all, select all messages, invert a previous selection, deselect all 
messages or forward an email as attachment. 

 
If any of the 'Group by' views are selected the result list, in the message list window, will be 
split in pages containing a defined number of messages (set in the WebMail Data tab). 
Navigation among pages is possible (go to first, next, previous, last, or specific (by number) 
page) and if actions are performed on items in a page the interface will remember the page 
name so when the user returns it will be the exact same page. 
 
Composing a new message 
To compose a new message, press on the New button. A pop-up window similar to the one 
below is displayed. 
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Steps for editing a new message in AXIGEN WebMail  

To edit an email message you need to take the following steps: 

1. Enter the email addresses of the recipients in the To: field of the message (separated 
by commas if multiple) or add them from your existing address book by pressing the 
Addressbook button. The Addressbook gives users access to contacts defined for 
their account and also to Public and Domain contacts. First select the needed contact 
list, then select a specific one. Email addresses can be added automatically to the 
'To', 'Cc' or 'Bcc' fields. To do so, click on the address to select it, then click the To, 
Cc or Bcc buttons. Press the OK button when you are done adding recipients or the 
Cancel button to quit. 

 

For any of these three address fields, when typing the recipient addresses, if the respective 
addresses are already in your address book, the auto complete function will be enabled. 
Therefore, you can select the correct address and press Enter. 

2. Use the Check addresses button to verify the validity of the email addresses you 
have inserted. 

3. Specify the subject of your message in the Subject: field. 
4. Use a different originating email address by clicking the Show From link (after the 

formatting buttons) and typing the address in the From field.   

WARNING! This option works only if the user has the 'Send Mail as' permission from the 
mailbox owner. 

For information on how to define 'Send Mail as' permissions please see Sharing 
permissions. 

5. Set the 'Reply-to' header for the email message. When clicking the 'Show Reply-To' 
link, a new field appears containing the email address defined in the settings window 
(which the user may override). If no value was defined in the Settings > Personal 
Data page the input field must be empty. 

6. Edit your message in the message body. The user can now use rich text (Bold, Italic, 
Underline / Strike through, Different font face and size, Colors, Subscript, 
Superscript, Insert link, Bullets etc.). 

7. Add attachments to your message by pressing the Attach button. To add an 
attachment, press on Browse, specify the path to the attachment and then press on 
the Upload link. To add multiple attachments, repeat these actions as many times as 
you need. 
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8. After adding one or more attachments to a WebMail message, the attachment list is 
displayed in the lower part of the screen. You can delete the attachments one by 
one, by clicking on the corresponding [delete] link. 

9. You can save a draft of your current message at any time by pressing on the Save 
button and resume its editing at a later time. 

NOTE: The WebMail interface currently allows users to request 'Read Receipts' when 
composing a new message as well as to optionally send a 'Read Receipt' when reading a 
message that was sent with the 'Request Read Receipt' option. 

10. You can access and change the Default ‘Read Receipt’ Settings by taking the 
following steps: in the ‘Settings’ tab, click on the ‘Edit Webmail Data’ option at the 
bottom of the ‘Webmail Data’ pane, and on the bottom-right side of the newly-
opened window you will find both the ‘Request Read Receipts’ and ‘Send Read 
Receipts’ options, with the selectable values of ‘yes’ and ‘no’, for the default 
settings. 

Marking messages 
To mark a message, you must first select it in the upper panel by clicking on it. Then choose 
one of the options displayed in the Mark as drop-down box: 

• Select Mark as read to set the status of the currently selected message(s) to Read. 
• Select Mark as not read to set the status of the currently selected message(s) to Not 

read. 
• Select Flagged to add a flag to the currently selected message(s). 
• Select Not Flagged to delete the flag for the currently selected message(s). This 

option is only available for previously flagged messages. 
• Select Deleted to mark a message as deleted (it will be displayed in strikethrough 

style). When marking certain messages as deleted, you can also choose to hide 
them by pressing the Hide deleted button  

• Select Not deleted to remove a deleted mark from a certain email message. 

 

 
 
Deleting messages 
To delete one or more messages, select the message(s) and click on the Delete button in 
the Main button bar. If you do not wish to see the deleted messages click the Hide deleted 
button. Deleted messages will be permanently deleted or sent to the Trash folder depending 
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on the user setting in WebMail Data or the Move deleted emails to Trash option set by the 
administrator in Account WebMail Options. 
 
1.4. WebMail Folders 

Public Folders 
Through the Public Folders, users may now share email messages, contacts, tasks etc. by 
simply copying and/or moving them to a public folder. System administrator can also 
associate a certain email address with a public folder. Thus, emails can be sent directly to 
the public folder, archiving options being also available. 

While they cannot permanently delete messages from the Public Folders, when using 
WebMail, users can mark the messages they choose as deleted and also hide the emails 
with such marks. Thus, users are not compelled to view messages that do not interest them. 

Users can set other types of flags for their Public Folders, such as Read/Unread or 
Flagged/Unflagged. These options affect the email messages of the respective individual 
account, not the actual content of the Public Folders. 

Special Folders 
From both WebMail and Outlook, one can create a special type of folder: Mail, Calendar, 
Tasks, Journal, Contacts, Notes. Each special folder has type-specific view to display its 
contents (i.e. Calendar view(es) for calendar-type folders, Contacts view for contact-type 
folders and so on). 

Aside from its specific view, each special folder type has a list view which consists of a list of 
objects in that folder. The list view has more pages so the user may view only a few items at 
a time. When editing an object in the list view, the user interface remembers the page so that 
after the object is updated the position in the list is not lost. 

While in the list view special messages can be copied or moved from one special folder to 
another, if the folders have the same type. This action can also be performed in Outlook. 

NOTE: After creation, the folder type cannot be modified. 

For special public folders all action buttons are displayed, regardless of the permissions. 
When editing an item, the action buttons in the edit pop-up are displayed or not depending 
on the permissions. For example if the current user does not have 'Edit' (i.e. delete & create) 
permission, the 'Save' button does not exist; moreover, all input controls are disabled. 

For information on how to set folder permissions please access the Sharing Permissions 
page. 

Managing Folders in WebMail 
Right click on any folder in the folder tree (be it personal, public or shared, mail, calendar, 
task, journal or notes) brings-up a context menu with the following options: New folder, 
Rename folder, Move folder, Empty folder, Delete folder, Sharing, Open/Close other user's 
folder. 

http://www.axigen.com/docs/60/Setting-Sharing-Permissions_439.html
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These options always appear in the context menu, if they work or not depends on the 
specific permissions set on the selected folders. 

When clicking any of these options new pop-up window is displayed allowing you to make 
the desired changes. 

For example when creating a new folder a new window is displayed allowing you to specify 
the name of the new folder in the Folder name text area, the Folder type (Email, Calendar, 
Tasks, Journal, Notes or Contacts) and select its location in the folder tree. To finish press 
the Create button or Cancel if you changed your mind. 

 
All folder options: creating, moving, deleting etc. have explicit instructions in their respective 
pop-up windows. 

Managing Contacts in WebMail 
To define your address book access the Contacts folder from the folder tree. You can either 
add them one by one or import an existing address book. 

 

Click the New contact button to create a new contact and fill in the details. 
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General Details 

 
Use the Email, First Name and Last name text fields to specify the name and email 
address of the new contact you want to add. To specify the contact's nickname, use the 
Nickname field. 

Additional Info 

 

You can specify a personal email, for non-professional purposes in the Personal email field, 
phone numbers in the Phone and Mobile Phone fields and the home phone and address 
data in the Home address and Home phone fields. 

Using the Business email field you can specify the business email address for your new 
contact. Use the Business phone and Business address fields to specify the office contact 
details. Finally the Notes text field can be used to type any information regarding the 
currently edited contact. 

Make sure to press the Save&Close button to save the contact you just added or the details 
you changed.  
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Edit the contact by double clicking on it. To delete an existing contact, use the Delete icon 
on the right of the contact you would like to remove.  To send a new email to a contact in the 
list click the letter icon (next to the Delete icon). Click the Details link to see all the 
information regarding that contact. 

 

Press the Import contacts button to import external address books that were saved locally. 

 

Address book files must be in CSV(Comma Separated Value) format! 

Click the Browse button to specify the path to the desired external address book, then click 
on the Import contacts button. Should you choose to abort, press the Cancel button. 

Any new created mailbox has by default two public folders in the root of the public folder: 
Domain Contacts and Public Contacts.  

The Domain Contacts folder is read-only: no items can be modified or created in it, it 
cannot be deleted or renamed, no folders can be added to it, no permissions may be 
changed on it.  

NOTE: This applies for all users in the domain, including postmaster! 

The content of this folder is automatically and dynamically updated by the server and 
contains all the email addresses for recipients in the domain. 

Public contacts can be added only by the domain Postmaster in the same way explained 
above. 

1.5. Working with the Personal Organizer in WebMail 
Having time management and mobility needs in mind, starting with version 4.0, the AXIGEN 
Mail Server comes with a Personal Organizer module available from both AXIGEN’s 
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WebMail interface and Outlook email client. The Personal Organizer comprises tools such 
as calendar, tasks, journal, notes and collaborative support.  

This section aims to explain how the new management tools can be used. Each of them - 
calendar, journal, notes, tasks - is described in a separate subsection, with all its features 
and usage alternatives.  

1.5.1. Working with your Calendar 

The Calendar helps users plan and schedule their work-related or personal events and to 
have a clear and detailed view of their work, thus enabling an improved time management. 
To access your Calendar, you can either click the Calendar folder in the folder tree structure 
placed on the left hand side of your WebMail account or click on any day of the calendar 
displayed in the lower left corner of the interface.  

 

The upper button bar displayed when the Calendar is accessed gives access to the following 
options: 

• New event - creates a new event. To create an event in a certain day, either select it 
first using the calendar displayed in the lower left corner. Use the left and right arrows 
to change months of the current year and the double right and left arrows to change 
the year. 

• Today - when hit, it marks the current day events 
• Day view - displays the events for one day at a time 
• Work-week view - displays work days, Monday to Friday 
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• Week view - displays the entire week 
• Month view - displays the events for the whole month 
• List view - displays the existing list of events.  

 

Creating a New Event 
When creating a new event, you have to first type a Subject (required) and then a location, 
specifying where the event takes place. You can either create an event that lasts throughout 
the day by checking the All day event option, or you can specify limits for the new event. To 
do so, click the date and time selection boxes for both the Start and End date of your event. 

 

Should you like to be prompted that a certain event is about to start, check the Reminder 
box and set your desired time interval. You can also use the available text field to type in any 
details or explanations regarding your current event.  Set the events transparency to "Busy" 
or "Free" using the drop-down menu in the “Show time as” section. This option will affect 
the resource availability displayed in the Free/Busy tab. More information is available below 
on this page.  

To save your event, press the Save & Close button. To abort configuring the event, hit 
Cancel. To define a repeating scenario, hit Recurrence and use the Invite button to invite 
others to attend the event you are creating. 
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Existing events can be edited at any given later date. To do so, select the desired entry by 
double-clicking it, regardless of the selected view type. After making the needed alterations, 
hit the Save & Close button. If the entry you want to edit is a recurring event, you will be 
asked whether you want to edit the entire series or only a single instance (occurrence) of the 
event: 

 

NOTE: This option is not available while in the list view. 

Should you like to delete the entry, press the Delete icon added to the editing window. 
Additionally, when using the List view, you can use the edit end delete icons appended to 
each event.  

 

Setting the Recurrence 
When hitting the Recurrence button, a pop-up window displays the available options. You 
can set a start and end time for the event by clicking the respective selection boxes. Thus, 
the Duration of your event will be automatically set. 

 

Click the Start selection box to select the starting date of the recurrence. You can choose to 
have the event repeated incessantly by checking the No end date option or the event can 
stop occurring after a number of occurrences (check the End after x occurrences option) or 
by a certain date (select the End by... option).  

You can set the event to o be repeated on a daily, weekly, monthly or yearly bases, 
according to a defined Recurrence pattern. Depending on the Recurrence pattern you select, 
you can access more detailed options: 
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• Daily - you can have the event repeated every weekday by checking the 
corresponding option, Every weekday, or you can have it repeated every 2,3, x days 
by checking the corresponding option. 

 

• Weekly - you can check a certain day(Monday to Sunday) of every 1/2/etc week(s) 
for the recurrence 

• Monthly - You can specify a certain day of every month (e.g. 25th of every month or 
every 2 months), or select from the other available options: 
first/second/third/fourth/last - day/weekday/weekend day/Sunday/Monday etc. of 
every 1/2/etc months. For example, you can set an event that occurs on the first 
weekday of every other month. 

Important! As the number of days differs depending on the month, if you set an event for 
the 31st, it will be scheduled in the last day of each month with 30 days. 

 

• Yearly - You can set the event to occur on a certain date of a certain month (e.g. 
January 25th) or you can select from the other available options: 
first/second/third/fourth/last - day/weekday/weekend day/Sunday/Monday etc. of 
every January/February/etc months. For example, you can set a seminar attendance 
event for each first weekend day of every March. 

 

Finally, set the Range of recurrence for your event. Click the Start selection box to select a 
date. The event can be repeated incessantly if you choose the No end date option. 
Alternately, you can have it ended after a number of instances, by checking the End after x 
occurrences option and setting the desired number of repeats, or set an End by date and 
selecting the desired end date by clicking the respective selection box.  
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When you are done setting the event recurrence hit OK. To abort the recurrence hit Cancel. 
For already defined recurrence details, hit Remove Recurrence to prevent the event from 
repeating. 

Inviting Attendees 
When hitting the Invite Attendees button, a new text field and a To button are added in the 
upper side of the event editing window. If you want to abort inviting process, press the 
Cancel Invitation button that replaces the initial Invite Attendees option.  

 

You can either type the email addresses of the persons you want to invite at the event, or 
you can access your existing contacts by hitting the To button. When accessing your 
contacts using the To button, a new pop-up window appears, allowing you to choose which 
contacts to display in the left hand pane, as shown below. Available options are 'All 
contacts', 'My contacts', 'Public contacts' and 'Domain contacts'. 

 

Select the email address of the contact you want to invite with a mouse click, then press the 
To button. To select several contacts, press Ctrl on your keyboard. To delete a contact from 
the list of attendees to be invited, click their email address in the right hand pane and press 
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Delete on your keyboard. When you are done selecting attendees, press OK to have the 
email invitations sent to them. To discard the inviting process, hit Cancel.  

 
Attendees will then receive an invitation email in their Inboxes, prompting them to take 
action: 

 
To view the details of the event they are invited to attend, users need to click on "open 
details". The available options are to Accept the meeting, to accept it without guaranteeing 
attendance - Tentative, Reject it, or Propose a change in the event details. 

When an attendee takes a certain action, other than Propose, the organizer receives a 
notification email that requires no further action to be taken.  

 
If, on the other hand, the invited attendees have proposed changes to the event, the 
organizer will receive an email prompting him/her to take action. The available options are 
Accept/Reject changes or Propose a new modification of the event specifics. 
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When dealing with proposed changes, attendees have one more option, Tentative, which 
gives them the possibility to accept the changes partially, without guaranteeing thy will 
actually take part in the event. 

 

Important! If participants to a certain event take different actions when changes are 
proposed (i.e. some accept them, while others reject them), the organizer has the final say. 

When inviting others to take part in a certain event, the event editing window will also be 
modified. A new tab called attendees will be added, showing the course of action taken by 
those invited. The available status options are 'Accepted', 'Declined', 'Tentative' and 'need 
action'. 

 

In the Free/Busy tab the attendee availability is displayed IF the user editing the event has 
the 'Read Free/Busy status' permission on the attendee's mailbox. This feature is available 
only in the WebMail interface. 
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Reminder options 
If you have chosen to be reminded of a certain event, at the specified time, a pop-up will 
appear at the given time and date. If no action is taken, it will reappear each time the 
WebMail interface is automatically refreshed. Hence, it depends on the refresh settings 
configured in the WebMail Data page. Alternatively, you can have the reminder postponed 
using the available snooze options, by choosing a repeat interval in the corresponding drop-
down menu and by hitting the Snooze button. 

Important! If the auto-refresh option is disabled, reminders will not function.  

 
If you want to see the details of an event you are reminded of, press the Open Item button. 
To dismiss a certain task, select it and press the Dismiss button. Use the Dismiss All 
button to discard all pending events. 

Important! Further settings that determine Calendar behavior need to be set on the 
WebMail Data page. Each user needs to set the correct Time Zone and the Week start date 
in order to have deadlines and start times displayed correctly in their Calendar. 

1.5.2. Working with your Journal 

The Journal allows you to add entries that help you keep track of your day-to-day tasks and 
actions. To access your Journal, click the corresponding folder in the folder tree structure 
placed on the left hand side of your WebMail account.  
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The upper button bar displayed when the Journal is accessed gives access to the following 
options: 

• New journal - creates a new journal entry.  
• Today - when hit, it marks the journal entries for the current day 
• Day view - displays journal entries for one day at a time 
• Month view - displays journal entries on a monthly basis 
• List view - displays the existing list of journal entries.  

Creating a New Journal Entry 
When hitting the New journal button, the options relative to the new entry are displayed in a 
pop-up window. 

 
To add a new entry, you have to fill in the two required fields: Subject, referring to the entry 
description, and the Type drop-down menu. There are several available types of entries, 
such as Phone call, E-mail Message, Task, Conversation, etc: 

 

Click the Start time selection boxes to set a starting date and time for your journal entry. In 
the displayed calendar, use the left and right arrows to change months of the current year 
and the double right and left arrows to change the year. 
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Click the Duration selection box to specify a time frame for your journal entry.  You can then 
edit the actual journal note in the available text field.  When you are done editing the entry, 
hit the Save & Close button. If you want to discard the journal entry, press the Cancel 
button. 
 
Existing Journal entries can be edited at any given later date. To do so, select the desired 
entry by double-clicking it. After making the needed alterations, hit the Save & Close button. 
Should you like to delete the entry, press the Delete icon added to the editing window. 

 

When using the List view, journal entries can be edited by double clicking on them and 
deleted by clicking their corresponding delete icon. 

 

Important! Further settings that determine Journal behavior need to be set on the WebMail 
Data page. Each user needs to set the correct Time Zone and the Week start date in order 
to have start and end times displayed correctly in their Journal. 

 

1.5.3. Working with your Notes 

The Note tool allows you to add quick notes while working. Notes are best suited when one 
needs to write down something very quickly and has little time to add more details.  To 
access your Notes, click the corresponding folder in the folder tree structure placed on the 
left hand side of your WebMail account.  
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When hitting the New note button a small pop-up window is displayed.  

 

Type the note in the given field and either close the pop-up window using your browsers "x" 
button, or hit the Close window to save this note link in order to have your text saved. 

Notes can be edited by double clicking on them and deleted by clicking their corresponding 
delete icon.  

1.5.4. Working with your Tasks 

Tasks helps users organize their work-related tasks and collaborate with others on ongoing 
projects. By enabling them to permanently check the level of completion, tasks offer a clear 
and detailed view of their workload. To access your Tasks, click the Tasks folder in the 
folder tree structure placed on the left hand side of your WebMail account.  
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The upper button bar displayed when the Tasks are accessed enables the following options: 

• New tasks - creates a new event.  
• All tasks - lists all your tasks 
• Uncompleted tasks - displays the user's uncompleted tasks 
• Completed tasks - displays the user's completed tasks 

Creating a New Task 
When creating a new task, first type a Subject in the corresponding text field, then set the 
task’s completion deadline using the Due Date selection box. Use the left and right arrows of 
the selection calendar to switch between months of a certain year and the double left and 
right arrows to switch between different years.  

 

To successfully define a time frame for the task, also configure its Start date, using the 
corresponding selection box. Furthermore, you can prioritize tasks using the Priority drop-
down menu. Available options are: 'Low', 'Normal' and 'High'. To keep track of the 
completion process, type a percentage in the %Complete text field.  

 
Should you like to be prompted that a certain event is about to start, check the Reminder 
box and set your desired time interval. You can also use the available text field to type in any 
details or explanations regarding your current task. 
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To save your task, press the Save & Close button. To abort configuring the task, hit Cancel. 
To define a repeating scenario, hit Recurrence and use the Assign task button to have the 
respective task assigned to different users. 

Existing tasks can be edited at any given later date by double clicking it. After making the 
needed alterations, hit the Save & Close button. To mark a task as completed, use the 
corresponding icon placed next to the Assign task button. Should you like to delete the 
entry press the Delete icon in the editing window. Additionally, you can use the delete icons 
appended to each task or check it as completed. 

Setting the Recurrence 
When hitting the Recurrence button you can set the task to o be repeated on a daily, weekly, 
monthly, yearly basis or according to a defined Recurrence pattern. Depending on the 
Recurrence pattern you select you can access more detailed options:  

• Daily - have the event repeated every weekday by checking the corresponding 
option, Every weekday, or you can have it repeated every 2,3, x days by checking 
the corresponding option. 

 

• Weekly - check a certain day of the week for the recurrence 
• Monthly - specify a certain day of every month (e.g. 25th of every month or every 2 

months), or select from the other available options: first/second/third/fourth/last - 
day/weekday/weekend day/Sunday/Monday etc. of every 1/2/etc months. For 
example, you can set an event that occurs on the first weekday of every other month. 

Important! As the number of days differs depending on the month, if you set an event for 
the 31st, it will be scheduled in the last day of each month with 30 days. 

 

• Yearly - set the event to occur on a certain date of a certain month (e.g. January 
25th) or you can select from the other available options: first/second/third/fourth/last - 
day/weekday/weekend day/Sunday/Monday etc. of every January/February/etc 
months. For example, you can set a seminar attendance event for each first weekend 
day of every March. 
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Then set the Range of recurrence for your task. Click the Start selection box to select a 
date. The task can be repeated incessantly if you choose the No end date option. 
Alternately, you can have it ended after a number of instances, by checking the End after x 
occurrences option and setting the desired number of repeats, or set an End by date and 
selecting the desired end date by clicking the respective selection box. 

 

When you are done setting the task recurrence hit OK. To abort the recurrence hit Cancel. 
For already defined recurrence details, hit Remove Recurrence to prevent the task from 
repeating.  

Assigning tasks 
When hitting the Assign task button, a new text field and a To button are added in the 
upper side of the event editing window. If you want to abort inviting process, press the 
Cancel Assignment button that replaces the initial Assign task option.  

 

You can either type the email addresses of the persons you want to assign the task to, or 
you can access your existing contacts by hitting the To button. When accessing your 
contacts using the To button, a new pop-up window appears, allowing you to choose which 
contacts to display in the left hand pane, as shown below. Available options are 'All 
contacts', 'My contacts', 'Public contacts' and 'Domain contacts'. 
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Select the email address of the contact you want to have the task assigned to with a mouse 
click, then press the To button. To select several contacts, press Ctrl on your keyboard. To 
delete a contact from the list of assignees, click their email address in the right hand pane 
and press Delete on your keyboard. When you are done selecting assignees, press OK to 
have the email assignments sent to them. To discard the assigning process, hit Cancel. 

 
Assignees will then receive an assignment email in their Inboxes, prompting them to take 
action: 

 
To view the details of the event they are invited to attend, users need to click on "open 
details". The available options are to Accept or Reject the task and the organizer receives a 
confirmation email.  
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When assigning tasks to others, the editing window will also be modified. A new tab called 
Attendees will be added, showing the course of action taken by those you have selected. 
The available status options are 'accepted', 'declined' and 'need action'.  

 

Reminder options 
If you have chosen to be reminded of a certain task, at a specified time, a pop-up will appear 
at the given time and date. If no action is taken, it will reappear after the starting time each 
time the WebMail interface is automatically refreshed. Hence, it depends on the refresh 
settings configured in the WebMail Data page. Alternatively, you can have the reminder 
postponed using the available snooze options, by choosing a repeat interval in the 
corresponding drop-down menu and by hitting the Snooze button. 

Important! If the auto-refresh option is disabled, reminders will not function.  

 
If you want to see the details of an event you are reminded of, press the Open Item button. 
To dismiss a certain task, click to select it, then press the Dismiss button. When a task is 
dismissed, it is also removed from the Reminder window. Use the Dismiss All button to 
discard all pending tasks. 

Important! Further settings that determine Tasks behavior need to be set on the WebMail 
Data page. Each user needs to set the correct Time Zone and the Week start date in order 
to have their Tasks deadlines and start times displayed correctly. 
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1.6. Configuring Account Settings in WebMail 
To access the WebMail account parameters, click Settings (right upper corner, WebMail 
upper right panel), next to the Logout link. In this section users are given access to eight 
configuration tabs: 

• Personal Data - containing options relative to the user's personal details; 
• WebMail Data - gives access to settings managing the webmail account behavior (all 

these parameters can also be configured by the administrator via WebAdmin from 
the Account > WebMail Data page); 

• Filters - gives access to filter configuration using the AXIGEN Rules Wizard; 
• Sharing permissions - gives share access to your folders (allow other users to see 

your schedule or send emails in your name); 
• RPOP Connections - this feature allows you to organize user's communication by 

retrieving email from other remote accounts; 
• Account Info - quota related parameters can be viewed in this page; 
• Blacklist - block email addresses you do not wish to receive messages from; 
• Temporary email - request one or more temporary email addresses (or alias); 

 
1.6.1. Configuring Personal Data 

While on the Personal Data page, users can define personal details such as their first and 
last name, change the current password to their WebMail account or fill in Business Details. 
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General Information 
To set your first and last name, use the two corresponding text fields, First name and Last 
name. To choose a nickname, use the Nickname field. 

Define a Reply-To header for all the messages you send (including replies and forwards) so 
when someone replies your email in the To field the email address set here appears instead 
of the one in the 'From' header.  When composing an email it can be overridden or missing if 
it was not defined.  

Personal Details 
You can specify a personal email, for non-professional purposes in the Personal email field.  

Add your phone numbers in the Phone and Mobile Phone fields and home phone and 
address data in the Home address and Home phone fields.  

Your Password 
The password previously defined by the administrator when creating the account can be 
changed from the Personal Data page. To do so, first type the current password in the Old 
password field, then type a new one using the Password field and finally confirm the new 
selected password in the Retype password field. 

Business Details 
Use the Business phone, Business address and Business email fields to specify your 
office contact details.  

After modifying any of these parameters, remember to press the Save changes button to 
save these changes. Use the Cancel button to undo the changes you have just made 
instead of saving them. 

1.6.2. WebMail Data Settings 

When accessing the WebMail Data page, users have access to settings used to configure 
the behavior of their WebMail account.  
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Appearance 
Use the Skin name drop-down menu to select the skin of your WebMail account. At this time 
three options are available: Classic, Coolwater and Webreflection. 

The Language drop down menu allows you to select the language of the WebMail account. 
Available choices are English (en), Romanian (ro), German (de), Norwegian (no), Dutch (nl), 
Spanish (es), Portuguese (pt), Italian (it), Danish (dk), Swedish (se), Chinese (cn), Persian 
(fa), French (fr), Greek (gr), Hungarian (hu), Macedonian (mk), Polish (pl), Russian (ru), 
Turkish (tr) and Czech (cz).  

The Page size text box allows the user to specify the number of messages displayed on one 
WebMail page. 

The HTML Body Filtering level specifies which HTML filtering level will be used when 
displaying HTML format messages. The HTML filtering level stand for the following:  

• No Filtering 
• Low level filtering -  converts the message to standard XHTML 
• Medium level filtering - generates the email body based on a list of known/allowed 

attributes and tags. Anything that is not on this 'allowed list' is removed. This level 
removes java script, styles, etc. 

• High level filtering - generates the email body based only on text components. This 
means that only plain text components remain in the message. This forth level is the 
strictest and may actually damage some formatting, but it is also the safest. 

Use the Week start date drop-down menu to select a day to be displayed first in the week 
for your calendar. To specify your Time Zone, use the corresponding drop-down menu. 

The date field is automatically adjusted according to the defined local time zone when 
displaying a message (in both the message list window and the open message popup). 

Preferences 
Choose to be asked for confirmation before emptying a folder using the Confirm empty 
folder drop-down box.  

Choose to ask for a confirmation when an email message is deleted using the Confirm 
delete mail drop-down menu. 

Use the Delete to Trash drop-down box to specify if a message deleted from your WebMail 
account is saved to Trash folder ("yes") or permanently deleted. 

To have a copy of sent messages saved in the Sent folder, choose the value "yes" for the 
Save to sent parameter.  

Set the refresh interval for your WebMail interface by typing the desired value in the Auto-
refresh interval text field. Please note that if you set this value to 0 it means that the option 
is disabled. 

Use the Display new email notification drop-down menu to choose if you wish to be 
notified when a new email arrives. 

Configuring your signature 
To configure a signature that will be appended to all your outgoing emails, use the 
Signature text field. 
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After changing any of the settings above, remember to press the Save changes button to 
save the new values.  

1.6.3. Mail Filtering in WebMail 

The filter wizard accessible from the Filters page allows users to easily create a filtering 
system to manage their email flow. Moreover, auto replies can be set for all or certain 
received email messages. 

When first accessing the Filters page, a list of the already defined filters is displayed. If no 
filter has been previously set, the list will be blank.  

 
The Sender not in AB Actions allows you to apply certain actions to messages containing 
recipients that are not in the address book. To enable this option just check the box in front 
of it and choose either of the Send NDR, Move to Trash or Discard options from the drop-
down list. 

To delete a filter, use the Delete button on the right of the respective filter. To edit an 
existing filter, press its corresponding Edit button. Click the New filter button to create a new 
filter. To create an automatic reply for certain/all messages hit the New responder button. 

Whether creating a new filter or editing an existing one the options displayed are the same. 
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Use the name text filed to specify a name for the currently defined filter. You can further 
select if the messages filtered should match all or any of the defined criteria using the 
corresponding check boxes.  

Next use the drop-down menu to select what conditions should the messages meet for the 
filter to apply. Available options include setting conditions relative to the subject, sender, 
receiver, Cc, To or Cc, size of the email, as well as a customization option accessible by 
choosing Custom. 

Finally use the Actions area to define the actions to be taken (i.e. moving, copying, deleting, 
or redirecting it to a certain email address etc.) if an email message matches the specified 
criteria.  

- use this icon to add a new criterion and/or a new action; 
- use this icon to remove one of the previously created criteria and/or actions. 

To set the order in which defined filters should apply use the up and down arrows in front of 
them. 

When setting a Responder (automatic reply) to be sent to the email messages matching the 
defined filter, the following fields also need to be configured: 

 
Use the Subject and the Message fields to define the subject and body of the email 
response to be sent. Set the Days between subsequent responses and Additional own 
email addresses (use the same responder for other email addresses) by editing their 
corresponding fields. 

When you are done configuring the filter or responder press the Save changes button. 

1.6.3.1. WebMail Filters Overview 
The mail filtering features allow users to create named filters and specify actions to be taken 
on the matching messages.  A filter is composed of a set of 'filtering expressions' or 
"expressions" and a set of actions. 

An expression (filtering expression) is composed of a header name, an operator and an 
optional value. The expression can be applied to a mail message and will give a 
matching/unmatching response. 
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A filter contains the following: 

• Name 
• Priority 
• Enabled/Disabled state 
• ExpressionOperator: operator to compose multiple filtering expressions (And/Or) 
• Expressions 
• Actions  

A (filtering) expression contains the following 

• Header: the mail message header the expression to witch the matching criteria will 
be applied 

• Operator: operator specific to the header type 
• Value(optional): a value that the operator may need (depends on the operator)  

Supported Headers/Operators/Values 

Header(s) Supported 
operators 

(negated or not) 

Supported values Comments 

Subject 
To 
To or Cc 
Cc 
Custom 

Contains 
Is 
Begins with 
Ends with 

String When Custom is selected 
the name of the custom 
header must be specified.

From Contains 
Is 
Begins with 
Ends with 

String   

Size Is greater than 
Is lower than 

String describing size, e.g.: 
1024 (bytes) 
1K (1 kilobyte = 2^10 bytes 
1M (1 megabyte = 2^20 bytes)
1.4G (1.4 gygabytes = 1.4 * 
2^30 bytes)  

  

Action Data 

Action Data Type Description 

Move to string The path to the location is given as 
UTF8 

Copy to string The path to the location is given as 
UTF8 

Delete 
(move to trash) 

(none) (none) The message will be moved to trash.

Forward to email address The message will be forwarded to 
the given email address. No copy will 
be saved. 
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Vacation days number mininum > 0 
maximum > 7 (must) 
maximum > 30 (should) 
if omitted, days defaults to 7 or 
minimum (whichever is greater) 
if given value > maximum, days 
defaults to maximum 
if given value < minimum, days 
defaults to minimum 

  subject  string (utf8) Alternate subject for response. 
If not given, the incoming mail's 
subject is used 

  text string (utf8) Body of the response message. 

Filter Container 
The FilterContainer is responsible for serializing an ordered collection of filters into a file and 
for parsing a sieve script that contains one or more filters. 

The parts of the scripts that are not recognized are stored as raw text in memory. When 
doing the serialization, the container will reorder the scripts. The ones that were edited by 
WebMail will be written at the beginning of the file while all 'raw' scripts will be written at the 
end. 

A script is recognized as being a WebMail script if: 

• contains only directives that have been implemented in webmail filters 
• has a header with the following data:  

o Name: user specified string 
o Id: internal integer to uniquely identify the script 
o Position: integer used for ordering the scripts 
o Enabled: boolean 

If the script has a header but has been edited by hand to contain other directives it is 
rejected and put into the raw scripts collection. 

If the script does not have a header but can be handled as a WebMail script it will be given 
an auto-generated id, a last position in the list and an auto-generated name. 
 

1.6.4. Setting Sharing Permissions 

In the Setting Sharing Permissions tab you can allow share access to your folders, access 
folders shared by other users, allow other users to see your schedule or send emails in your 
name.  
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Global Permissions 

 

Read Free-Busy status 
If a user editing a calendar event has the 'Read Free-Busy' permission for the attendee's 
mailbox the availability is displayed. 

Send Mail As 
When sending a new email message another 'From' address can be set if the user has the 
'Send Mail As' permission for that mailbox. 

Folder permissions 
These permissions can be defined on both folder level and on mailbox level (in this case, 
they act on all subfolders in the user's mailbox). To share a folder right click on it and choose 
share. 

 

Share a folder  
To control a folder's sharing permissions, go to the tree folder on the left, right click on it and 
choose the Sharing option. When accessing Sharing options for a folder a list of the already 
defined permissions is displayed. If no permission has been previously set the list will be 
blank.  

 
To edit an existing permission use its corresponding Edit button, to delete it hit the recycle 
bin shaped Delete button. Click the Add button to add a user or a group of users (only 
domain contacts are available) and set the permission level on the folder. There are 6 levels 
to choose from: 

• No access (all permissions are denied) 
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• Viewer (view and read folder is allowed) 
• Contributor (view, read folder and add items is allowed) 
• Editor (view, read folder, set/clear flags, add items, mark items as deleted/not deleted 

and expunge is allowed) 
• Master (all permissions are allowed) 
• Custom (each permission is defined individually according to your needs) 

 
Each permission may be allowed explicitly, denied explicitly or not specified. Permissions act 
hierarchically (are inherited on the group hierarchy). Additionally, resource hierarchies (a 
folder being parent to another folder) also benefit from the inheritance algorithm. In the 
Effective Permissions tab you will be able to see what permissions are specifically allowed or 
not. 

 
IMPORTANT! In the same way domain Postmasters set permissions for Public Folders. 
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Subscribe to folders shared by other users 
Click the Subscribe button to have access to folders shared by other users. You can either 
type the email address in the Shared by field or click the Select button to choose it from the 
contacts list in your domain. 

 

WARNING! This option works only for users in the same domain that have set one of the 
permissions level (except None) described above. 

The folder will appear in the Shared Folders section of your folder tree: 

 
If you do not wish to see the folders shared by a certain user anymore close them by right 
clicking on the folder displaying the user's name or one of its subfolders and choosing the 
Close user option. 

1.6.5. Configuring WebMail RPOP Connections 

When first accessing the RPOP Connections tab, a list of the already defined connections is 
displayed. If no connections have been previously set, the list will be blank.  

 
To delete a RPOP connection, click the Delete icon corresponding to it. To edit a 
connection, click the Edit icon corresponding to its name. In order to add a new connection, 
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press the Add connection link. Whether you are adding or editing a RPOP connection, the 
parameters you need to configure are the same.  

 

 

Connection details 
Specify the name or IP address of the host from which the emails are retrieved using the 
Hostname field. To set the port on which the retrieval from the desired hostname is made, 
use the Port field. 

Use the Username and Password fields to specify the authentication details needed to 
connect for email retrieval.  

Retrieval settings 
Use the Retrieval interval field to specify the minimum interval in minutes between two 
email retrievals. Then specify a certain folder of your WebMail account where you want the 
emails stored using the Folder field. You can also select if email messages are deleted or 
not from the remote server after retrieval, using the Delete on retrieval drop-down box. 

Security 
Select the desired type of encryption used on the RPOP connection you are configuring from 
the Encryption drop-down menu. The available options are 'none', 'SSL' and "TLS'. Use the 
Enable APOP drop-down box to specify if you want to enable APOP authentication for the 
respective connection. 

RPOP Templates 
Emails from Yahoo or Gmail accounts are now available in your WebMail account with the 
RPOP Templates. Click Add Yahoo! Mail/Gmail, fill in the account name, password, set the 
retrieval settings and click the Save connection button to create a new RPOP entry 
containing defaults for the selected email provider (Yahoo, Gmail).  
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By default, a new folder is created in Inbox named 'Gmail mail' or 'Yahoo mail'. The user can 
choose not to use the default but instead pick a folder from the list (in this case no new folder 
is created). 

WARNING: POP3 access is only available for Yahoo! Mail Plus users. 

When you are done configuring these parameters, remember to press the Save connection 
button.   

1.6.6. WebMail Account Information 

The Account Information page allows users to view data relative to their mailbox quota. 
They can verify at any time the total quota of their mailbox, their used and remaining quota.  

 
 

The Total Quota value is set by the server administrator and cannot be modified by the user. 
The used and remaining quota values change dynamically as the WebMail account total 
message size changes. 
 

1.6.7. WebMail Blacklist 

When accessing the Blacklist tab in WebMail Settings you can make a list of email 
addresses you do not wish to receive emails from. When first accessing this page there are 
no email addresses in the list. 
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To add an address to the Blacklist, type it in the Email: text filed and click the Add button. 

If you entered your list an email address by accident or you do not wish to block it anymore 
click its corresponding delete button. 

 
1.6.8. Requesting Temporary Email Addresses 

When accessing the Temporary Email tab you can request one or more temporary email 
addresses (or alias) that can be used for publishing on the web, subscribing to various sites 
etc.  

 
When you click the Generate button the server automatically creates a random valid alias 
(out of letters and numbers, in the same domain as the user) and activates it. As long as the 
addresses exist they are treated as account aliases, meaning mail sent to those email 
addresses is received in the user's Inbox. 

They can be manually deleted by clicking the Recycle Bin button next to it or automatically 
expire after a specified period. The expiry period as well as the number of temporary email 
addresses you can request are set by the server administrator at domain or account level 
and cannot be modified by the user. 
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Chapter 2. Using AXIGEN WebMail features in Outlook 
This section describes how you can take full advantage of all AXIGEN's features and 
capabilities when using Outlook as your email client. The AXIGEN Outlook Connector 
enhances the communication of Microsoft's email client with the AXIGEN server allowing a 
smoother cooperation.  

2.1. Installing the AXIGEN Outlook Connector 
The AXIGEN Outlook Connector comes with an installation wizard and needs to be setup on 
each machine using Outlook as an email client and having messaging communications 
handled by the AXIGEN Mail Server. The installation process is an extremely easy three-
step procedure, as shown below.  

Important! The AXIGEN Outlook Connector requires Outlook 2003 /SP2, version 11.8010.x 
or later. 

To run the wizard, double-click the executable file which will then prompt the wizard 
welcome window. Click Next to start installing.  

 
The second step consists in reading and agreeing to the End-User License Agreement. Click 
I Agree to start the actual installation process or Cancel to quit installing the connector. 
Click Back to go back to the welcome window. 

 

 

 

 



                        

                        

                       AXIGEN User Manual 
 

 Copyright © 2009 Gecad Technologies S.A. 46 

http://www.axigen.com

If you agree to the product EULA, the AXIGEN Outlook Connector will be installed. To exit 
the setup wizard, click Finish, as shown below.  

 
After running the setup wizard, you will have to configure Outlook for use with the AXIGEN 
Outlook Connector. To do so, please follow the steps below: 

1. Add a new Outlook profile, if you don't have one: 

1.1. Go to Start-> Control Panel -> Mail applet. 

1.2. Select 'Show Profiles...' -> 'Add...' , add a name for your new profile, select 'Ok'. 

2. Add a new account to the profile you have just added: 

2.1. From the 'E-mail' section, choose 'Add a new e-mail account'. 

2.2. In the 'E-mail Accounts' dialog, 'Server Type' section choose 'Additional Server 
Types'. 

2.3. In 'E-mail Accounts' dialog, 'Additional Server Types' section choose 'Axigen Mail 
Server'. 

3. Fill all required settings for the 'Axigen Outlook Connector' service: 

 

 

 

 



                        

                        

                       AXIGEN User Manual 
 

 Copyright © 2009 Gecad Technologies S.A. 47 

http://www.axigen.com

3.1. Fill in the 'Server Name' edit control with the IP or server name of the Axigen Mail 
Server. If you do not have the required information, please contact your system 
administrator for more details. 

3.2. Fill in the 'IMAP Port' and 'SMTP Port' fields, with the ports on which the IMAP and 
SMTP services are listening (Example: IMAP - 143 / SMTP - 25). If you do not have 
the required information, please contact your system administrator for more details. 

3.3. Enable the 'Windows Native (kerberos)' option so the connector will use the 
credentials of the logged in user to authenticate to the AXIGEN account (if the 
server is configured to allow this type of authentication). Enabling this option 
disables the account name and password fields since the current user credentials 
from the kerberos ticket will be used. 

3.4. Fill in the 'Account Name' and 'Password' fields with the account name and 
password provided by your mail server administrator. 

3.5. Check the 'Use secure authentication' option to instruct the Connector to use 
secured authentication. If the server is not configured to allow this type of 
authentication enabling this option will yield login failure. 

3.6. Use the 'Remember Password' option so you won't have to type it in each time you 
open Outlook. 

3.7. Click the 'Test Connection...' button to verify that the details you entered are correct 
and complete and your account is working.  

4. Start Outlook and select the profile name you have added at step 1 from the 'Choose 
Profile' dialog. 

2.2. Server Side Rules 
Users can easily create a filtering system to manage their email flow with the Server Side 
Rules. When first accessing the Mail Processing Rules window a list of the already defined 
filters is displayed. If no filter has been previously set the list will be blank. 

 
To edit or delete an existing filter select it and use the Edit or Delete buttons. Change 
priorities between filters by selecting them and using the Up and Down buttons.  

Click the New button to create a new filter. Whether creating a new filter or editing an 
existing one the options displayed are the same. 
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- use this icon to add a new criterion and/or a new action; 

- use this icon to remove one of the previously created criteria and/or actions.  

Select what conditions should the messages meet for the filter to apply. Available options 
include setting conditions relative to the subject, sender, receiver, Cc, To or Cc, size of the 
email, as well as a customization option accessible by choosing Custom. Next select if the 
filtered messages should match all or any of the defined criteria. In the second window edit 
the conditions previously selected by clicking an underlined value. 

 
Click the Cancel or Next button to quit/continue editing the filter. 

Further define the actions to be taken (i.e. moving, copying, deleting, or redirecting it to a 
certain email address etc.) if an email message matches the previously specified criteria. In 
the second window edit the selected actions by clicking an underlined value. 

 
Click the Cancel/Next button to quit/continue editing the filter or the Back button to go back 
to the conditions window. 
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Finally use the name text field to specify a name for the currently defined filter and enable it 
by checking the Turn on this rule option. Review the rule description to make sure it is 
defined correctly and click the Finish button. 

 
You can quit editing the rule by clicking Cancel or go back to the Actions window by hitting 
the Back button. 

2.3. Folder Sharing 
To control a folder's sharing permissions, go to the tree folder on the left, right click on the 
folder you wish to set permissions on, choose Sharing  or Properties and in the new 
window select the Folder Permissions tab. When accessing this tab for a folder a list of the 
already defined permissions is displayed. If no permission has been previously set the list 
will be blank. 
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Check the Apply to subfolders option so the permissions set for the current folder will be 
automatically applied to its sub-folders. Click the Add button to add a user or a group of 
users and set the permission level on the folder. There are 6 levels to choose from: 

• No access (all permissions are denied)  
• Viewer (view and read folder is allowed)  
• Contributor (view, read folder and add items is allowed)  
• Editor (view, read folder, set/clear flags, add items, mark items as deleted/not deleted 

and expunge is allowed)  
• Master (all permissions are allowed)  
• Custom (each permission is defined individually according to your needs) 

 
Each permission may be allowed explicitly, denied explicitly or not specified. Permissions act 
hierarchically (are inherited on the group hierarchy). Additionally, resource hierarchies (a 
folder being parent to another folder) also benefit from the inheritance algorithm. In the 
Effective Permissions tab you will be able to see what permissions are specifically allowed 
or not. 

 

IMPORTANT! In the same way domain Postmasters set permissions for Public Folders. 
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2.4. Open/Close other user's folders 
To have access to folders shared by other users go to the Tools menu > Axigen Mail Server 
> Open other user’s folder… or right click on a folder in the folder tree and choose Open 
other user's folders... from the contextual menu. A warning will pop-up asking you to allow 
access to the email addresses stored in Outlook, check the Allow access for option, choose 
the desired time interval from the drop-down menu and click Yes. 

 
The address book will open and you will be able to select from the list or type the address of 
the user whose folder you wish to subscribe to. 

 

WARNING! This option works only for users in the same domain that have set one of the 
permissions level described above (except No access). 

The folder will appear in the Shared Folders section of your folder tree: 
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If you do not wish to see the folders shared by a certain user anymore close them by going 
to Tools > Axigen Mail Server > Close other user's folders or right click on a folder in the 
folder tree and choose Close other user's folders from the contextual menu. In the new 
window that will pop-up, select the user and click Ok. 

 

2.5. Manage Global Permissions 
To manage the Read free/busy status and Send Mail As permissions in Outlook go to 
Tools > Axigen Mail Server > Manage Global Permissions…. In the new window a list of 
users that have either of the two permissions defined is displayed. Each user in the list can 
be deleted or configured using the Delete and Edit buttons. 

 
To add a user to the list click the Add button. In the new window click the Select user… 
button to open the address book and choose a contact, then check the Allow or Deny 
options for the two permissions. 

 
When clicking the Select user button a warning will pop-up asking you to allow access to the 
email addresses stored in Outlook, check the Allow access for option, choose the desired 
time interval from the drop-down menu and click Yes. 
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In the Effective Permissions tab you will be able to see what permissions are specifically 
allowed or not. 

 
 

2.6. Additional User Options 
Starting with version 7.1, the AXIGEN Outlook Connector features improved performance 
and fresh productivity-enhancing new functionalities. It now supports working in offline mode, 
meaning that users no longer have to be connected to the server in order to access and 
manage emails, contacts or groupware and collaboration items (calendar, tasks, notes, 
journal entries etc) from MS Outlook. All changes performed in offline mode are 
automatically synchronized with Axigen Mail Server once the access to the network is 
restored. 

The Synchronization Settings can be found on the bottom-half of the ‘Settings’ window 
that opens at the end of the following path: File -> Data File Management -> Select a Data 
File from the list -> then click the ‘Settings’ button.  

The Improved AXIGEN Outlook Connector, in a nutshell:  
• Offline mode available 
• SSL communication to server 
• Auto-preview functionality 
• Cached local .pst file 
• Per-folder synchronization levels 
• Improved search and mail access speed 
• Read receipts 

Among these functionalities, the ability to cache locally information regularly available only 
on the server and new indexing methods are the most important. In order to be able to use 
the offline mode and other features of the Connector, the compatible version of the AXIGEN 
Mail Server must be installed. 
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Chapter 3. Working with the Mobile WebMail Interface 
The new mobile WebMail interface of AXIGEN Mail Server 6.1 enables users to access their 
WebMail account from mobile devices with Internet access to check their emails, 
compose/delete messages, set permissions on folders and much more.  

To enable mobile WM interface login to WebAdmin, select the WebMail service and check 
the Enable Mobile User Interface option in the Webmail Options section. 

The mobile Webmail Interface is accessible from the following browsers: 

• NetFront 
• Teleca 
• OpenWave 
• SEMC (Sony Ericsson low-end, mid-range) 
• Pocket Internet Explorer 
• WebKit (Symbian Series 60 browser, iPhone Safari) 
• Nokia Series 40 
• Opera (Mini, Mobile) 

When accessing the mobile WebMail interface through a browser, the individual user can 
read/compose/delete messages, view his INBOX and other folders, download attachments, 
move messages to another folder, perform searches and set permissions on folders. 

The following sub-sections will present how to do all the above when using a PDA.  

3.1. Accessing/Leaving the Mobile WebMail Interface 

Connecting to the AXIGEN mobile WebMail interface 
To connect to the Mobile WebMail Interface enter in your mobile phone browser the IP:port 
combination where your AXIGEN WebMail service is running. In the displayed window enter 
your account username and password and select the Login button. 

 

Check the Remember username option so you won’t loose time typing it each time you 
want to login. 
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Leaving the AXIGEN mobile WebMail interface 

 
 
To close the current WebMail session, click the Logout link (after your username) at the 
bottom of the section you are currently accessing. The Logout link is available in all sections 
of the mobile interface for an easy session ending.  

3.2. Navigating in Your Mobile WebMail Account 
When accessing your mobile WebMail account the current folder displayed is set by default 
to INBOX: 

 
The messages are ordered by their received date and grouped in sections. Each section 
corresponds to a date and contains all received messages in that day: 

• Today – for messages from the current date 
• Yesterday – for messages from the current date minus one day  
• DD MMM - for messages from the current year (for example 21 Jan) 
• DD/MM/YYYY - for messages from previous years ( for example 24/12/2005) 

The folder tree helps you browse and manage the emails in your account. You can copy or 
move messages in between folders, change the currently displayed folder and manage 
permissions. 

WARNING! Special type folders (calendar, tasks, notes etc.) are not accessible from the 
mobile interface. 

Navigation trough emails is also possible with the navigation links Next/Previous. If the 
mobile device supports JavaScript the ‘+’ and ‘-‘ icons in front of parent folders can be used 
to collapse / expand their sub-folders.  
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Contacts folder 

 
Select the Contacts folder to modify, update and use your personal contacts. To view or edit 
details for a contact select it from the list to open the 'contact details' section. To delete a 
contact select the Delete this contact link at the end of this pane. 

 
To create a new contact select New contact and fill in the details (First Name, Last name, 
Email address). Choose Save to preserve or Cancel to abandon. 

Searching emails 

 
To perform a quick search through the messages in the current folder scroll down to its end, 
type your query in the search filed and select Search Mail.  
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3.3. Working with Messages 
When viewing messages in the mobile interface the following fields are displayed: header, 
message body and controls. Click on the message subject to open the message reading 
window. 

 
The header contains details such as: Date/Time (if the message is from the current date), 
Subject, From, To, Cc and Bcc (if they were filled in) and number of attachments. 

All Addresses 

 
Click the All addresses link to display the complete list of recipients for an email message - 
From, To, Cc and BCC (where these fields exist) - and add them in the address book by 
clicking on the email address link. 

Attachments 
Select the x attachment(s) link to display the files attached to the current message. They are 
displayed one per line with previews (thumbnails) for .gif, .jpg, .jpeg and .png image formats. 
Click on the attachment name to download the file on your mobile device so you won’t have 
to login to your email account in order to access it. 
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If the message has more than 5 attachments you can browse trough them with the help of 
the navigation links Next/ Previous page. 

 

Use the action links at the end of the message to perform different operations on the current 
email: 

• use the navigation links Next/Previous message to browse trough messages 
• select Reply/Reply all to reply the sender or all the recipients of the email message 
• use Forward to redirect the email to a another recipient 
• select Delete to remove the current message 
• use Move to in order to move the email message to a different folder 
• select Copy to so another copy of the current message is created in another 

selected folder 
• use Block sender to add the sender’s email address to the blacklist 

Composing a new message 
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A new message can be created either by selecting the Compose link at the right top corner 
of any folder you are browsing or as a result of Replying/Forwarding an already received 
message.  

To edit an email message take the following steps: 

1. Enter the email addresses of the recipients in the To: field (separated by commas if 
multiple) or add them from the address book by selecting the To: button. The 
address book gives users access to contacts defined for their account and also to 
Public and Domain contacts. 

 
Select one or more contacts by ticking the checkbox in front of each contact. Clicking on 
a contact link returns to composing the email and adds the email address of that contact 
to the specific field (To, Cc or Bcc). 

2. Specify the subject of your message in the Subject: field. 
3. Edit your message in the message body. 
4. Select Send to send the email message, Save to save a draft of the current message 

and resume its editing at a later time or Cancel to abandon and return to the section 
where you previously were. 

 
5. Use the Show Cc/ Bcc link to add more recipients, from the address book, in the 

appropriate field. 
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3.4. Manage Folder Permissions 

Share a folder 

 
To control a folder's sharing permissions access All email folders in the main window and 
select the  (Manage permissions) icon next to the folder name. When accessing this menu 
a list of the already defined permissions is displayed. If no permission has been previously 
set the list will be blank. 

 
To edit an existing permission click the username (only the level can be modified), to delete 
it hit the recycle bin shaped Delete button. Select Add permissions to add a user or a 
group of users and set the permission level on the folder (only standard permission levels 
are available). 

 

WARNING! Custom permissions cannot be set from the mobile interface. 
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Subscribe to folders shared by other users 
To have access to folders shared by other users select the Open other user’s folders link 
after you access All email folders in the main window. You can either select the email 
address from the contacts list in your domain by choosing User/Group or type it in the field 
below. 

 

NOTE: This option works only for users in the same domain that have set one of the 
permissions level mentioned above. 

The folder will appear in the Other user’s folders section of your folder tree: 
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